D3 Design Philosophy

D3 products are read by decision- and policymakers worldwide. These individuals have limited time to spend on reading reports and updates. To serve these customers, our designs emphasize simplicity, minimal ornamentation, and maximum comprehension. All design decisions should be made with the following watchwords in mind:

- **Minimalism**
  Design with as few elements as possible.

- **Consistency**
  Similar elements should have similar formatting. This is not limited to just color and stroke weights. Leader lines, for example, should all run in the same direction or at the same angle throughout the graphic. Strokes and leader lines should always be .25 pts. and no darker than 80% black.

- **Alignment**
  Alignment is all about organizing elements relative to a line or margin. Textboxes or graphic elements, etc. should align along a grid.

- **Relevancy**
  There should be a reason for every graphic decision.

- **Subtlety**
  Educated readers prefer more sophisticated designs.

Know your Audience

Our readers are primarily men, age 50+, who are highly educated and in positions of leadership. Senior Leaders have shared that the perfect article is one they can absorb in under a minute. If you’re having a hard time reading or making sense of something, our readers are likely to have the same reaction. They are smart, but impatient.

Design Elements to Avoid

Design is subjective, and most guidelines are flexible. These elements, however, are either inappropriate for use with our audience and subject matter, or would tend to make our products look amateurish.

- **Flags**
  Most readers can’t identify a foreign country’s flag which necessitates adding a label. If we have to spell out the country name, then we don’t need the flag. If an author insists on using flags, involve a team lead and discuss creative ways to depict them that are less objectionable.

- **Multicolored Gradients**
  In an infographic every color meaning. The random quality of multicolored gradients makes them inappropriate for use with intelligence products.

- **Dark Drop Shadows**
  Drop shadows should never be darker than 30%.

- **Text Effects**
  In an infographic, the text serves to identify graphic elements, not outshine them. Leave the fancy text effects for promotional materials.

- **Anything Playful**
  Warp effects, 3-D effects, ribbons, and cast shadows create a more playful, informal feel, and are not appropriate with our audience and subject matter.
Inconsistent Sizes
Text sized consistently throughout a product ensures readability. Even subtle changes to size or leading can be extremely distracting to readers.

Inverted Hierarchy
Don’t allow supporting elements (legends, borders, etc.) to draw attention away from key elements (primary annotations).

Graphic Frames & Captions
All graphics* are pasted into a table—called the Graphic Frame—to ensure consistent placement of elements through all D3 documents, and to ensure that the elements (classification, banner, captions, visualization request number) remain together as the graphic is repositioned during the layout process. The Graphic Frame includes the following elements:

Graphic Classification
All graphics must display an overall classification.

Graphic Banner
Add a title for all graphics except photographs.

Graphic Caption
Add the graphic caption into the caption cell. Delete cell if there is no graphic caption.

Graphic Content
Paste the group of graphic components into this cell.**

Graphic Lower Edge
A 1.5 pt stroke to mark the bottom edge of the graphic.

Visualization Credit and VR Number
Identifies the graphic as a D3 Design product and allows us to locate the file for later reuse/updates.

Cell Strokes
Visible cell strokes make it easy to see all the cells in the Graphic Frame, but they’re not something to show in the final graphic. Set cell stroke weight to zero pts after placing everything into the Graphic Frame, including the stroke that separates the caption and the graphic.

Style Breakdown: Graphic Frames for DID Graphics

<table>
<thead>
<tr>
<th>Classification Cell</th>
<th>Graphic Classification</th>
</tr>
</thead>
<tbody>
<tr>
<td>• All Caps</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Graphic Caption Cell</th>
<th>(U) Graphic Banner</th>
</tr>
</thead>
<tbody>
<tr>
<td>• No italics</td>
<td>(U) Graphic caption: Delete cell if no graphic caption.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Graphic Content Cell</th>
<th>Visualization Credit and VR Number</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Visualization: DIA, D3 Design • XXXX-XXXXX</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Graphic Lower Edge</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Should match banner color</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Graphic Side Edges</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Use only when background is white and the graphic is not full width of the page</td>
</tr>
</tbody>
</table>

* Tabloid-sized graphics involve more elements and manipulation, thus their are not placed into graphic frames.
** Make sure Clip Contents to Cell is selected. Highlight the graphic that has been pasted into the graphic cell, go to Table>Cell Options>Text>Clipping
Photo Frames & Captions

Photos that stand on their own as complete graphics—i.e., editorial photos—must have captions. Photos that are part of a larger graphic—head shots within a tonebox or table, for example—are not required to have captions. Photo Frame ensures consistent placement and spacing for classification, photo, and photo caption. The Photo Frame includes the following elements:

Classification Cell
Photos and their captions are considered to be separate elements, each requiring its own classification. Captions incorporated into the graphic are considered to be part of the graphic, so a caption’s classification does affect the graphic’s overall classification.

Photo Caption Cell
Add the photo caption into the caption cell.

Visualization Request (VR) Number
Align the VR number to one of the corners of the photo. Left or Right corner is preferred. Group the VR number with the graphic before pasting into the graphic frame.

Intro Sentence
DID Staff guidelines require photo captions begin with a description of what the photo is depicting. DID Graphic guidelines require this introductory sentence be bold unless the caption is only one sentence. In this case do not bold the one sentence.

Image Frame
Photos require image frame.

Proper Resolution
D3 standard photo resolution is 120 dpi; resolution for print products is 300 dpi.

Multiple Photos
When multiple photos are ganged-up together they form a single graphic in a tonebox (3” or 6”) and follow the same rules/styles as toneboxes. See example below.

Round Image Frames
Avoid using round image frames on headshots when there’s no space around the head. When possible, use Photoshop to create more space.

D3 standard photo resolution is 120 dpi; resolution for print products is 300 dpi.

Style Breakdown: Photo Frames

(U) Multiple Photos

Round Image Frames:

- Avoid using round image frames on headshots when there’s no space around the head. You can add a space above the head in Photoshop.
- Use .25 pt size 80% black stroke
Imagery

In addition to those elements required for photos (resolution, caption, etc), Satellite imagery needs additional markings. By agreement with NGA, the imagery markings must be embedded in Photoshop (not added in Illustrator or InDesign). The Imagery includes the following elements:

Clean Imagery
If NGA-provided imagery has NGA markings then ask the Ops Officers to obtain “clean” imagery.

North Arrow
When north isn’t “up” in satellite imagery, use a north arrow.

Locator Map

Admin Information
Imagery Date: In upper-left corner.
Imagery Classification: In lower-left corner.
Declass Date: In lower-right corner.

Visualization Credit and VR Number
North Arrow—When north isn’t “up” in satellite imagery,

Inset Graphics

Inset maps are used to highlight information that would be difficult to perceive at the scale of the main map. An effective inset map follows the same design principles as any map, even though it is featured in a smaller frame, but all symbols and text should be consistent with the symbols and text on the main map. Here are three ways to treat inset graphics:

Same Color Image Frame
Stroke should not be more than .5 pts.

Transparent callout boxes
Data should still be visible and legible.

Labeling the frames
Use numbers or alphabets to label the matching inset frames.

Pie Graph

Pie graphs compare multiple elements within a single category. Pie graphs aren’t always eye-catching, so creativity is encouraged. Keep note of the following styles when creating pie graphs:

Text no smaller than 7.5 pts. to ensure readability.
Avoid using strokes on pie wedge.

Include a legend if a pie has more than 3 small sections or if the labels are lengthy.

Bar/Line Graphs

Bar graphs (horizontal, vertical, or stacked) and line graphs (with or without data points) show comparisons among distinct entities. Line graphs showing data points allow readers to compare the specific values of the elements depicted. Graphs without data points only allow readers to compare trends over time. Keep note of the following styles when creating bar/line charts:

Text no smaller than 7.5 pts. to ensure readability.
Scale lines should be .25 pts. and no darker than 80%.
Scale baseline should be .75 pts. and no darker than 80%.

Legend could be stacked or/and in one row on the top or bottom of the graph. Use a background box to ensure contrast with the graphic background.
Diagrams

Text-heavy diagrams like organizational charts must be done within InDesign, using paragraph- and character styles rather than manually formatting the text elements. Diagram text should be no smaller than 7.5 pts. to ensure readability and no bigger than 10 pts.

Tables

Text-based graphics like tables must be created in InDesign. Pick from one of the three table options in the components page of DID template for all DID graphics. Non DID graphics could use these templates as well, but it’s not a must. Paragraph styles are available for all table elements. Create additional styles as needed, do not manually format text elements.

- Vertical borders can be eliminated when there is sufficient white space between entries.
- Horizontal borders can be replaced with alternating fills.
- Do not apply alternating fills to tables with less than 4 rows.
- Stroke that separate the rows should not be bigger than .5 pts.
- Never use both fills and borders to separate cells.
- De-emphasize cell borders to keep focus on the content.

Timelines

Timelines—another text-based graphic—depict multiple events over time. For all DID graphics, use one of the two options for Timeline on the components page of InDesign templates. For all non-DID graphics there is plenty of flexibility when creating a timeline. Paragraph styles are available for all timeline elements. Create additional styles as needed, do not manually format text elements.

Maps

Maps display geographically relevant data, such as area boundaries, element locations, and travel routes. Reduce file sizes by flattening and rasterizing layers, leaving specific data of interest (rail lines, range rings, areas of control, etc.) in vector format to maintain their details. All the maps include the following elements:

- Overall Classification
  All maps must display an overall classification.
- Locator Map
  When a map shows just part of a country, add an locator map showing the entire country and neighboring areas to give readers an understanding of location.
- Scale Bar
- Map Legend
- Visualization Credit and VR Number
Map Labeling
Maps have specific cartographic requirements for labeling, which foster a cohesive look among all D3 Design products; use these standards when labeling map features. For the complete description of map cartographic standards, please see the D3 Cartographic Quick Guide.

Location Symbols
With one exception, labels are not placed directly to the left or right of the icon they identify. Labels may only be placed directly to the left or right when the icon is on a leader line.

Geopolitical Features
- Country names are labeled in ALL CAPS.
- Labels for capital should be heavier than other cities.

Range Rings
- Labeling range rings is preferred, but use your best judgement if you think legend works better with your map. (when labeling the range rings use leader lines if range rings are too close to each other).

Port Towns
Labels are placed within the body of water to identify the location as a port.

Country Names
Labels are placed wholly inside the country borders. When names don't fit completely, see the approved abbreviations list.

Rivers
Labels are placed on a path, above and following the river's contour. (place under only to prevent readability issues)

Water Features
Water features are identified with blue italic labels.

Terrain Features
Terrain features (Mountain, Desert, Canyon, Valley, etc.) are identified with italic labels.

FOAs and SOAs
All maps with FOAs and SOAs should have the word “boundary” in the legend and it should be sentence case. For example: “Provincial boundary” and “District boundary”
Other Design Elements
Icons - Symbols - Color Treatments

Measurements
• For DID graphics, you must use these icons for measurement. These icons are used mainly in tables.

![Measurement Icons](image)

Small Icons
Custom icons add a great graphic touch to maps, charts, and tables, but they lose their effectiveness when they’re too small. If your graphic requires icons to be smaller than .17 inch, then lose the icon and just go with a simple geometric shape. Keep icons same size on graphic and legend.

Stroke Points
When plotted points overlap, it’s easy to misjudge their numbers if there's no contrast between them. To fix this, add a .25 pts. white stroke to the symbol.

Stop Light Colors
![Stop Light Colors](image)

Qualitative Data
Data has no quantifiable value; thus, colors should not be hierarchical as in Sequential or Divergent Data Colors.

Sequential Data
Data starts at a given value and increases or decreases; thus, the color must start at a given color and increase in hue or saturation.

Divergent Data
Data passes through 0/normal value; thus, color must also pass through a 0/normal value.

D3 Commonly Used Map Symbols
![Map Symbols](image)

VOLUME TWO \ FEBRUARY TWO THOUSAND AND NINETEEN
Grid
A grid system is a way of organizing content on a page, using a combination of margins, guides, and columns. Consult with a senior designer if you need to break out of the grid.

Typography
Typographic styles—predefined combinations of text attributes—have been created for all text elements; use these exclusively and without deviation when preparing DID/D3 products. The proper use of styles ensures a consistent look across all agency products. Keep in mind these typographic guidelines:

**Consistent Sizes**
Text is sized 7.5 pts. and up to ensure readability.

**Styles**
Need different text formatting? Create a new style, and do not overwrite the existing styles.

**Optimal Column Widths**
Text can be hard to read when columns are too wide or too narrow. The optimal text width is 1.5 alphabets wide. The maximum is 2 alphabets, minimum 1 alphabet wide.

**Condensed Fonts**
Condensed fonts are harder to read, so avoid using small point sizes and light colors.

**Free-Styling**
For text elements that already have paragraph style applied to them but still require text formatting, reformat the text and save the new formatting as a new style. Do not reformat the existing paragraph style.

**All Caps**
Limit All Caps to short runs (2-3 words at most) as in table column headings and graphic labels. Do not use All Caps when acronyms are present.

Tabloid Graphics
Tabloid size (11x17) products consist of textboxes and multiple graphics. Component graphics use graphic frames/banners and each graphic gets its own classification. The following admin information is required when disseminating a product.

**Overall classification**
**Title of the product**
**Publish date**
**Assessment**
**Source Summary Statement**

**Author’s Office and Contact info**
**Declass Block**
**PCN**
**ICOD**
**VR#**

D3 Color Palette
Apply the D3 color palette to all Finished Intelligence Products.

**Transparency**
Do NOT use tints of colors as lighter values have been provided in the palette.

**Gray Out Your Colors**
Some readers receive black and white photocopies of our products that fall within their areas of interest. To ensure they see graphics as you intend, proof your graphics on screen in grayscale to ensure all values are distinct.

**508 Compliance (Adobe Illustrator CC)**
View > Proof Setup > Color Blindness
**D3 Color Palette**

### Full Print Palette

<table>
<thead>
<tr>
<th>Red</th>
<th>Coral</th>
<th>Brown</th>
<th>Orange</th>
<th>Gold</th>
<th>Khaki</th>
<th>Grass</th>
<th>Green</th>
<th>Teal</th>
<th>Ocean</th>
<th>Blue</th>
<th>Navy</th>
<th>Plum</th>
<th>Purple</th>
<th>Pink</th>
<th>Gray</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="100%25" alt="Red" /></td>
<td><img src="90%25" alt="Coral" /></td>
<td><img src="80%25" alt="Brown" /></td>
<td><img src="70%25" alt="Orange" /></td>
<td><img src="60%25" alt="Gold" /></td>
<td><img src="50%25" alt="Khaki" /></td>
<td><img src="40%25" alt="Grass" /></td>
<td><img src="30%25" alt="Green" /></td>
<td><img src="20%25" alt="Teal" /></td>
<td><img src="10%25" alt="Ocean" /></td>
<td><img src="10%25" alt="Blue" /></td>
<td><img src="10%25" alt="Navy" /></td>
<td><img src="10%25" alt="Plum" /></td>
<td><img src="10%25" alt="Purple" /></td>
<td><img src="10%25" alt="Pink" /></td>
<td><img src="10%25" alt="Gray" /></td>
</tr>
</tbody>
</table>

### Map Colors

- Study country & border
- Secondary country & body
- Non study country & border
- Body of water
- CI study & border
- CI secondary country & border
- CI non study country

### Full Print Palette Color Sets

- **Cool**
- **Standard**
- **Slim-RB**
- **Slim-OT**

### Supplemental Palette

All D3 Graphics should use colors obtained from the Full Print Palette. Only when there is a need for an *absolute vibrancy* should graphics use from the supplemental color palette.
Country Abbreviations

Afghanistan: Afg.
Albania: Alb.
Algeria: Alg.
American Samoa: Am. Sam.
Andorra: And.
Angola: Ang.
Anguilla: Ang.
Antarctica: Ant.
Antigua and Barbuda: Ant. & Barb.
Argentina: Arg.
Armenia: Arm.
Aruba: Abu.
Ashmore and Cartier Islands: Ash. & Cart. Is.
Australia: Aust.
Austria: Aus.
Azerbaijan: Az.
Bahrain: Bahr.
Baker Island: Bak. I.
Bangladesh: Bangl.
Barbados: Barb.
Bassas da India: Bass. da Ind.
Belarus: Bela.
Belgium: Bel.
Belize: Belz.
Benin: Ben.
Bermuda: Berm.
Bhutan: Bhu.
Bolivia: Bol.
Bosnia and Herzegovina: Bos. & Her.
Botswana: Botsw.
Bouvet Island: Bouv. I.
Brazil: Braz.
British Indian Ocean Territory: Br. Ind. Oc. Terr. / B.I.O.T.
British Virgin Islands: Br. Vir. Is.
Brunei: Brn.
Bulgaria: Bulg.
Burkina Faso: Burk.
Burma: Burm.
Cabo Verde: Cab.
Cameroon: Camer.
Canada: Can.
Cayman Islands: Cay. Is.
Chad: Chad.
Chile: Chile.
China: China.
Christmas Island: Christ. I.
Clipperton Island: Clip. I.
Cocos (Keeling) Islands: Cocos Is.
Colombia: Col.
Comoros: Comor.
Congo, Republic of the: Rep. of the Congo
Cook Islands: Cook Is.
Coral Sea Islands: Coral Sea Is.
Costa Rica: C.R.
Cote d’Ivoire: C. d’Iv.
Croatia: Cro.
Cuba: Cub.
Curacao: Cur.
Cyprus: Cyp.
Czech Republic: Czech Rep.
Denmark: Dan.
Djibouti: Dj.
Dominica: Dom.
Ecuador: Ecuador.
Egypt: Egypt.
El Salvador: ElSal.
Equatorial Guinea: Equatorial Guinea.
Eritrea: Erit.
Ethiopia: Eth.
European Union: E.U. or EU.
Falkland Islands (Malvinas): Falk. Is.
Faroe Islands: Faroe Is.
Fiji: Fij.
Finland: Fin.
France: Fr.
French Polynesia: Fr. Pol.
Gabon: Gabon.
Gambia, The: Garm.
Gaza Strip: Gaz. Str.
Georgia: Geo.
Germany: Ger.
Ghana: Ghana.
Gibraltar: Gib.
Glorioso Islands: Glor. Is.
Greece: Gre.
Greenland: Grnl.
Grenada: Gren.
Guadeloupe: Guad.
Guam: Guam.
Guatemala: Guat.
Guernsey: Guern.
Guinea: Gui.
Guinea-Bissau: Gui.-Bis.
Guyana: Guy.
Haiti: Haiti.
Heard Island and McDonald Islands: He. I. & M.D. Is.
Honduras: Hond.
Hong Kong: H.K.
Howland Island: How. I.
Hungary: Hung.
Iceland: Ice.
India: India.
Indonesia: Indo.
Iran: Iran.
Iraq: Iraq.
Ireland: Ire.
Isle of Man: I. of Man.
Israel: Israel.
Italy: Italy.
Jamaica: Jam.
Japan: Japan.
Jarvis Island: Jer. I.
Jersey: Je.
Johnston Atoll: John. A.
Jordan: Jordan.
Juan de Nova Island: J. de No. I.
Kazakhstan: Kaz.
Kenya: Ken.
Kingman Reef: King. R.
Kiribati: Kir.
Kosovo: Kos.
Kuwait: Kuw.
Kyrgyzstan: Kyr.
Laos: Laos.
Latvia: Lat.
Lebanon: Leb.
Lesotho: Leso.
Liberia: Liber.
Libya: Libya.
Liechtenstein: Liech.
Lithuania: Lith.
Luxembourg: Lux.
Macau: Macau.
Macedonia: Maced.
Madagascar: Madag.
Malawi: Mal.
Malaysia: Malay.
Maldives: Mal.
Mali: Mali.
Malta: Malta.
Martinique: Mart.
Mauritania: Maur.
Mauritius: Mau.
Mayotte: May.
Mexico: Mex.
Micronesia, Federated States of: Micronesia.
Midway Islands: Mid. Is.
Moldova: Mold.
Monaco: Mon.
Mongolia: Mong.
Montenegro: Mont.
Montserrat: Monts.
Morocco: Mor.
Mozambique: Moz.
Namibia: Nam.
Nauru: Naur.
Navassa Island: Nav. I.
Nepal: Nepa.
Netherlands: Neth.
New Caledonia: N. Cal.
New Zealand: N.Z.
Nicaragua: Nic.
Niger: Niger.
Nigeria: Nig.
Niue: Niue.
North Island: Norf. I.
North Korea: N. Kor.
Norway: Nor.
Oman: Oman.
Pakistan: Pak.
Palau: Pal.
Palmyra Atoll: Palm. A.
Panama: Pan.
Paracel Islands: Paro. Is.
Paraguay: Paraguay.
Peru: Peru.
Philippines: Phil.
Pitcairn Islands: Pit. Is.
Poland: Pol.
Portugal: Port.
Puerto Rico: P.R.
Qatar: Qatar.
Réunion: Reu.
Romania: Rom.
Russia: Rus.
RWanda: Rw.
Saint Barthélemy: St. Barth.
Saint Helena, Ascension, and Tristan da Cunha: St. Hel.
Saint Kitts and Nevis: St. Kitts & Nevis.
Saint Lucia: St. Luc.
Saint Martin: St. Mar.
Saint Pierre and Miquelon: St. Pler. & Mq.
Saint Vincent and the Grenadines: St. Vin. & Gren.
Samoa: San.
San Marino: S. Mar.
Sao Tome and Principe: S. To. & Princ.
Saudi Arabia: Saudi. Ar.
Senegal: Sen.
Serbia: Ser.
Seychelles: Seych.
Sierra Leone: S. Leoa.
Singapore: Sing.
Sint Maarten: St. Maart.
Slovakia: Slovak.
Solomon Islands: Sol. Is.
Somalia: Som.
South Africa: S. Af.
South Georgia and South Sandwich Islands: S. Ga. & S. Stwch. Is.
South Korea: S. Kor.
South Sudan: S. Sudan.
Spain: Span.
Spratly Islands: Spr. Is.
Sudan: Sudan.
Suriname: Sur.
Svalbard: Sval.
Swaziland: Swaz.
Sweden: Sve.
Switzerland: Switz.
Syria: Syria.
Taiwan: Tai.
Tajikistan: Taj.
Tanzania: Tanz.
Thailand: Thai.
Timor-Leste: Tim. -Les.
Togo: Togo.
Tokelau: Tok.
Tonga: Tong.
Trinidad and Tobago: Trinidad & Tob.
Tromelin Island: Trom. I.
Tunisia: Tun.
Turkey: Turk.
Turkmenistan: Turk.
Uganda: Ug.
Ukraine: Ukr.
United Arab Emirates: U.A.E.
United Kingdom: U.K.
United States: U.S.
Uruguay: Uru.
Uzbekistan: Uzb.
Vanuatu: Vanu.
Vatican City: Vat.
Venezuela: Ven.
Vietnam: Viet.
Virgin Islands: Vir. Is.
Wake Island: Wake. I.
Wallis and Futuna: Wal. & Fut.
West Bank: W. Bank.
Western Sahara: W. Sah.
Yemen: Yem.
Zambia: Zam.
Zimbabwe: Zimb.

US STATES
Alabama: Ala.
Alaska: Al.
Arizona: Ariz.
Arkansas: Ark.
California: Calif.
Colorado: Colo.
Connecticut: Conn.
Delaware: Del.
District of Columbia: D.C.
Florida: Fla.
Georgia: Ga.
Hawaii: Haw.
Idaho: Idaho.
Illinois: Ill.
Indiana: Ind.
Iowa: Iowa.
Kansas: Kans.
Kentucky: Ky.
Louisiana: La.
Maine: Maine.
Maryland: Md.
Massachusetts: Mass.
Minnesota: Minn.
Mississippi: Miss.
Missouri: Mo.
Montana: Mont.
Nebraska: Nebr.
New Mexico: New Mexico.
New Hampshire: N.H.
New Jersey: N.J.
New York: N.Y.
North Carolina: N.C.
North Dakota: N.D.
Ohio: Ohio.
Oklahoma: Okla.
Oregon: Ore.
Rhode Island: R.I.
South Carolina: S.C.
South Dakota: S.D.
Tennessee: Tenn.
Texas: Tex.
Utah: Utah.
Vermont: Vt.
Virginia: Va.
Washington: Wash.
West Virginia: W. Va.
Wisconsin: Wis.
Wyoming: Wy.


Note: The US Board on Geographic Names will no longer update or maintain the source listed above. This listing is based on the 1998 publication with updates to be discussed by the full board.
# CAPCO
## Intelligence Community Markings System | Classification Quick Reference Sheet

### US Classification Markings
- Only one from this category
- Highest classification supercedes lower classifications

**TOP SECRET (TS)**  
(Potential for exceptionally grave damage to national security)

**SECRET (S)**  
(Potential for serious damage to national security)

**CONFIDENTIAL (C)**  
(Potential for damage to national security)

**UNCLASSIFIED (U)**  
or, some documents may include Non-US markings

### Non-US Protective Markings
- For use with FGI-obtained material
- Only one from this category
- Non-US markings always preceded with a double slash

// [Non-US Classification] [Trigraph]

Authorized non-US classification markings are:  
- **TS** for TOP SECRET  
- **S** for SECRET  
- **C** for CONFIDENTIAL  
- **R** for RESTRICTED  
- **U** for UNCLASSIFIED

ex., //R DEU

Classifications must appear on every text and graphic portion within a document, and must be included in the page header and footer.
- Classification markings are comprised of the markings categories identified here.
- Categories are always arranged in the order depicted here.
- Multiple markings within the same category are separated by a single forward slash (/).
- Multiple markings within the same category always occur in the order depicted here.
- Classification markings from different categories are separated by a double forward slash (/).  
- Overall graphic classification markings, and Document classifications in the page header and footer areas, are never abbreviated and may not use parenthesis.  
- Individual portion markings are abbreviated, appear within parentheses, and must occur at the beginning of the portion (text portions and graphic portions).

### SCI Control System Markings
- May use multiple markings from this category
- SCI markings have restrictions for use with other markings
- Markings used must appear in the following order:

**HCS-P** — HUMINT Collection System-Production  
**HCS-O** — HUMINT Collection System-Operations

**SI** (aka COMMINT)  
(May not be used with UNCLASSIFIED; NOFORN is required)

**-GAMMA (-G)**  
(Requires TOP SECRET, SI, and ORCON)  
(Uses hyphen, not a slash, to separate from SI)

**TK** — Talent Keyhole  
(Requires TOP SECRET or SECRET; with imagery requires RSEN)

### Dissemination Control Markings
- May use multiple markings from this category
- Dissemination Control markings have restrictions for use with other markings
- Markings used must appear in the following order:

**RSEN (RS)** — Risk Sensitive  
(May be used only with TOP SECRET or SECRET; May be used with TK)

**FOUO** — For Official Use Only  
(May be used only with UNCLASSIFIED)

**ORCON (OC)** — Originator Controlled  
(Not approved with ORCON statement)

**ORCON-USGOV (OC-USGOV)**  
(May not be used with UNCLASSIFIED)  
(Pre-approved for release to congress)  
(Does not run with an ORCON statement)

**IMCON (IMC)** — Controlled Imagery  
(IMCON material must be classified as SECRET)  
(IMCON material without NOFORN requires explicit use of REL TO)  
(May be used with NOFORN when appropriate)

**NOFORN (NF)** — Not Releasable To Foreign Nationals  
(Can not be used with REL TO or RELIDO)

**PROPIN (PR)** — Proprietary Information

**REL TO USA, [Trigraph]** — Authorized for Release To [List]  
(Countries are represented with trigraph codes)  
(USA must be listed first in the REL TO string)  
(Also uses other country trigraphs must be listed alphabetically)  
(Each code is separated by a comma and a space)  
(Can not be used with NOFORN)

**RELIDO** — Releasable by Information Disclosure Official  
(May be used independently or with REL TO; Can not be used with NOFORN)

**DSEN** — DEA Sensitive  
(For use with UNCLASSIFIED)

**FISA** — Foreign Intelligence Surveillance Act  
(Requires the document carry a FISA warning as required by law)

### Foreign Government Information Markings
- Countries are represented with trigraph codes
- Trigraph codes must be listed in alphabetical order

**FGI [Trigraph]** — Foreign Government Information  
(May be used with REL TO and NOFORN)

### Non-IC Dissemination Control Markings
- May use multiple markings from this category
- Non-IC Dissemination Control markings have restrictions for use with other markings
- Markings used must appear in the following order:

**LIMDIS (DS)** — Limited distribution  
(May only be used for UNCLASSIFIED information)

**EXDIS (XD)** — Exclusive Distribution  
(May not be used with UNCLASSIFIED)  
(EXDIS and NODIS may not be used together)

**NODIS (ND)** — No Distribution  
(May not be used with UNCLASSIFIED)  
(NODIS and EXDIS may not be used together)

**SBU (SBU)** — Sensitive But Unclassified  
(May only be used for UNCLASSIFIED information)

- For use with UNCLASSIFIED information
- When only SBU-NF information is used within a document, add the “SBU” marking to the banner and RELIDO is added as a Dissemination Control Marking
- RELIDO is not used in the banner line if any portion of the document contains SBU-NF information. NOFORN supersedes REL TO in the banner line.

**SBU NOFORN (SBU-NF)** — Sensitive But Unclassified NOFORN  
(May only be used for UNCLASSIFIED information)

- Notes:
  - When SBU-NF and FOUO information is used within a document, add the “SBU” marking to the banner and NOFORN is added as a Dissemination Control Marking
  - REL TO is not authorized in the banner line if any portion of the document contains SBU-NF information. NOFORN supersedes REL TO in the banner line.

**LES (LES)** — Law Enforcement Sensitive  
(May only be used for UNCLASSIFIED information)

- Note:
  - When LES information is used within a classified document, add the “LES” marking to the banner and REL TO [List] is added as a Dissemination Control Marking

**LES NOFORN (LES-NF)** — Law Enforcement Sensitive NOFORN  
(May only be used for UNCLASSIFIED information)

- Note:
  - When LES-NF information is used within a classified document, add the “LES” marking to the banner and NOFORN is added as a Dissemination Control Marking

**SSI (SSI)** — Sensitive Security Information  
(May only be used for UNCLASSIFIED information)
Senior Review Checklist

6” Graphic Frame
- Overall classification with .25 pt. stroke underneath
- Title
- Left and right edge rules if necessary
- D3 visualization credit right aligned
- Bottom rule if graphic is not defined

Graphic Frames Inside Tabloid
- Overall classification
- Title
- Bottom rule if graphic is not defined

DID Photo
- Overall classification
- Caption
- Image frame
- D3 credit (just the VR #)

Imagery
- Appropriate use of Photoshop template
  - 3 corners
  - Directional arrow
- Locator map
- No image frame
- Saved as a flat .png

Bar Chart
- .25 pt. scale lines
- .75 pt. base line
- Either all horizontal or vertical axis lines
- Axis labels

Pie Chart
- Consistent leader lines with circle ends
- No default wedge strokes
- Color: multiple values of same hue preferred to multiple hues

Table
- Use of table text styles
- Appropriate alternating row colors (applies to tables with more than 4 rows)
- Either horizontal or vertical rules (unless it’s done nicely)
- D3 visualization credit aligned right
- No title heading for titles such as name, country, quantity, date, etc.

Timeline
- No colon for date if date is on its own line
  - Example:
    2014
    text text text
    text text text
- Don’t repeat the year in body text
  - Example:
    2013:
    2014: October 2014- Wrong
    2015: October - Correct
    2016:
- Icons used for measurement are white and not see through
- Legend icons 75% smaller than actual icons
- Legends are aligned center on the bottom

Map legend
- Use image frame if blending with the background
- Icons in legend are same size as they are on the map
- Icons are aligned center

Layout
- Correct overall classification
- 4 corners (correct seals, publish date, declassify box, ICOD and PCN)
- Title is repeated in the title bar of inside pages (for multiple page documents)
- Appropriate use of grid and text columns
- DRAFT layer is turned on
- Clear hierarchy

Source Summary Statement
- Author, contributed, and coordinated line
- Paragraph styles and character styles are applied
- Created new paragraph styles and character styles instead of refining existing ones (only applies to DIDs)
- Map annotations are done all in Illustrator
- Map and locator map are grouped and pasted in the graphic frame
- Tables and textboxes with color background are not two separate layers/objects